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Safety Symbols on Instruments
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Indicates warning or caution. If you 
see this symbol on a product, you 
must refer to the manuals for 
specific Warning or Caution 
information to avoid personal injury 
or damage to the product.

Frame or chassis ground terminal. 
Typically connects to the 
equipment’s metal frame.

Indicates hazardous voltages and 
potential for electrical shock.
Indicates that antistatic 
precautions should be taken.

Indicates hot surface. Please do 
not touch.

Indicates laser radiation turned on.

CSA is the Canadian certification 
mark to demonstrate compliance 
with the Safety requirements.
CE compliance marking to the EU 
Safety and EMC Directives.

ISM GRP-1A classification 
according to the international EMC 
standard.

ICES/NMB-001 compliance 
marking to the Canadian EMC 
standard.
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Safety Summary

General Safety Precautions

The following general safety precautions must be observed during all phases of operation of this instrument. 
Failure to comply with these precautions or with specific warnings elsewhere in this manual violates safety 
standards of design, manufacture, and intended use of the instrument.

Agilent Technologies Inc. assumes no liability for the customer's failure to comply with these requirements.

Before operation, review the instrument and manual for safety markings and instructions. You must follow these 
to ensure safe operation and to maintain the instrument in safe condition.

General

This product is a Safety Class 1 instrument (provided with a protective earth terminal). The protective features of 
this product may be impaired if it is used in a manner not specified in the operation instructions.

All Light Emitting Diodes (LEDs) used in this product are Class 1 LEDs as per IEC 60825-1.

Environment Conditions

This instrument is intended for indoor use in an installation category II, pollution degree 2 environment. It is 
designed to operate at a maximum relative humidity of 95% and at altitudes of up to 2000 meters.

Refer to the specifications tables for the ac mains voltage requirements and ambient operating temperature 
range.

Before Applying Power

Verify that all safety precautions are taken. The power cable inlet of the instrument serves as a device to 
disconnect from the mains in case of hazard. The instrument must be positioned so that the operator can easily 
access the power cable inlet. When the instrument is rack mounted the rack must be provided with an easily 
accessible mains switch.

Ground the Instrument

To minimize shock hazard, the instrument chassis and cover must be connected to an electrical protective earth 
ground. The instrument must be connected to the ac power mains through a grounded power cable, with the 
ground wire firmly connected to an electrical ground (safety ground) at the power outlet. Any interruption of the 
protective (grounding) conductor or disconnection of the protective earth terminal will cause a potential shock 
hazard that could result in personal injury.

Do Not Operate in an Explosive Atmosphere

Do not operate the instrument in the presence of flammable gases or fumes.

Do Not Remove the Instrument Cover

Operating personnel must not remove instrument covers. Component replacement and internal adjustments must 
be made only by qualified personnel.

Instruments that appear damaged or defective should be made inoperative and secured against unintended 
operation until they can be repaired by qualified service personnel.
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Environmental Information
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About this document
Purpose
6

This document provides the information of Open Base Station Architecture Initiative (OBSAI) 
protocol tester.Every OBSAI system specification is in accordance with the Open Base 
Station Architecture Initiative rules and procedures.
Scope
The document defines the overall architecture and the interfaces involved in it. This provides 
a more detailed specifications and implementation of OBSAI protocol tester. OBSAI protocol 
tester has two interfaces: GUI and API. This document covers only the GUI aspect of the OBSAI protocol tester. 
For information on API, please refer to the online help.
Audience
The document defines the overall architecture and the interfaces involved in it.The intended 
audience of this document are Research and Development (R&D) professionals,trained 
personnels, integration and verification teams. Also, the production might be interested of 
using the OBSAI protocol tester.
OBSAI Protocol Tester User’s Guide
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Introduction
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This chapter introduces you to the Open Base Station 
Architecture Initiative (OBSAI) protocol tester. It gives an 
overall information about the system. It includes, 
architecture information, scope and accessing and exiting of 
OBSAI protocol tester.
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1 Introduction
About OBSAI Protocol Tester
10
Agilent OBSAI protocol tester is an advanced verification 
system that allows you to generate and capture data traffic 
simultaneously. This physical layer data which you capture, 
you can view and analyze to identify problems. You can also 
find their root cause and troubleshoot them. This makes 
OBSAI protocol tester a very effective tool to control as well 
as speed up the testing.

A brief list of features of OBSAI is given below:

• Enables to verify traffic between Baseband Module (BBM) 
and Radio Frequency Module (RFM).

• Provides multiple active links.

• Enables flexibility to configure complete frames

• Enables multiple error insertion points to test designs in 
faulty conditions.

• Enables in quick analysis with the use of trigger 
conditions.

• Generates and captures data traffic which includes error 
insertion and detection simultaneously.

• Enables to perform root cause and performance analysis.

• The OBSAI protocol tester is compliant to Reference Point 
3 specification (RP3) version 4.0, and Reference Point 1 
specification (RP1) version 2.0.

• Provides a stable and reliable system in order to execute 
verification without debugging the test equipment.

• The test equipment supports the following OBSAI 
interfaces RP1, RP3 and RP3- 01 (optical).
OBSAI Interface Tester User’s Guide 12
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OBSAI Architecture Overview
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The OBSAI family of specifications provides the architecture, 
function descriptions and minimum requirements for the 
integration of a set of common modules into a Base 
Transceiver Station (BTS). As a minimum, the BTS has the 
capability to be configured from a set of common modules in 
order to support more than one current or future wireless 
network access standards. Internal interfaces between BTS 
functional blocks designated as Reference Point 1 (RP1), 
Reference Point 3 (RP3).
Figure 1 OBSAI Architecture

In Figure 1, each block represents a logical separation of 
BTS functions in protocol processing. A block represents a 
logical grouping of a set of functions and attributes. A block 
may consist of one or more modules, each of which 
represents a physical implementation of a subset of the 
block functions.
Reference Point Functions
Reference Points are the connectivities between RF and 
Baseband modules of a base station:

• Reference Point 1(RP1)

• Reference Point 3(RP3)
11
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Reference Point 1(RP1)

RP1 interchanges control, performance, status, alarm and 
data provision between the Control and Clock Block and 
other BTS blocks with the protocol specified in the OBSAI 
RP1 specification. RP1 also defines an open, standardized 
interface for exchange of clock and synchronization signals 
that meet the timing, frequency stability, phase noise and 
jitter constraints of supported air interfaces. The interface 
employs a common clock rate for generation of system clock 
signals for all blocks and modules within each block.

Reference Point 3(RP3)

RP3 interchanges, formatted air interface user and signalling 
data user between the BaseBand Block and the Remote RF 
Block.
OBSAI Interface Tester User’s Guide 12
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The scope of OBSAI protocol tester is to test and debug the 
RP3 and RP3- 01 interfaces for HW and ASIC designs used in 
R&D. Presently, it only tests the functionality till the link 
layer. It is used to verify that the OBSAI interfaces of the 
products are working according to OBSAI standard 
specification. These designs requires the following:

• Transmitting RP3 and RP3- 01 data to the Device Under 
Test (DUT). It includes, good data and error frames.

• Receiving and analyzing RP3 and RP3- 01 data from the 
DUT. It includes frame structure checking, and uploading 
the data to a computer for post processing

• Sending and receiving of control messages
Figure 2 Scope of OBSAI Protocol Tester
13



1 Introduction
Baseband Emulation to Validate RF Module
14
OBSAI protocol tester is emulating the RF module. In case of 
missing Clock and Control module, it provides the RP1 
synchronization interface.
Figure 3 RF Module Testing
RF Emulation to Validate the Baseband Module
OBSAI protocol tester is emulating the Baseband module. In 
case of missing Clock and Control module, it provides the 
RP1 synchronization interface.
Figure 4 Baseband Module Testing
System Testing
OBSAI protocol tester provides traffic on RP3 and RP3- 01 
interface between RF module and Baseband module. As an 
interconnect:
OBSAI Interface Tester User’s Guide 12
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• Dedicates connector board between edge connectors of 
modules

• Probe interface e.g. retainer

In case of missing Clock and Control module, it provides the 
RP1 synchronization interface.
Figure 5 System Testing

In conclusion, OBSAI protocol tester is data link tester for 
RP3, RP3- 01, RP1, and eth interface. It can also emulate 
Baseband, RF module, Remote RF module, and/or Control 
and Clock module (CCM).
15



1 Introduction
Session Concept
16
Communication between the controller PC and the serial I/O 
modules is based on the concepts of sessions. A session is a 
representation of the instrument components involved in a 
test:

• The control software running on the controller PC

• The serial I/O module involved in the test

The following figure indicates the components involved in a 
session. It also indicates how more than one client can log 
onto one session.
Figure 6 Session Concept

To use a session, it is necessary to:

• Start and configure the session: This is when you 
establishes communication between the client and the 
control PC.

• End the session: This is when you quit using a session 
and the last one using the session, you are prompted as 
to whether the session should be ended. Ending a session 
clears the Serial I/O Module, allowing it to be used for a 
new session.

All accesses to the test system must go over the session. The 
session is not locked, but concurrent access to one session is 
possible.
OBSAI Interface Tester User’s Guide 12



Introduction 1
Using a Session at Several Computers
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If a session is up and running, you can use it from multiple 
instances of the user interface (for example, from different 
clients) or from tcl scripts. This is helpful if you want to set 
up a test system directly at the controller PC and then run 
a series of tests from your PC.

The controller PC does not protect against meaningless or 
even conflicting requests. It is therefore, recommended that 
only one user should “own” a particular session at a time.

To connect to a current session in the user interface, you 
need to note the session number and then select this session 
when the software starts.
17



1 Introduction
Accessing and Exiting Protocol Exerciser for OBSAI
18
This chapter introduces you the method of accessing the 
Protocol Exerciser for OBSAI protocol tester application. And 
the various GUI components of the Protocol Exerciser for 
OBSAI application.
Accessing Protocol Exerciser 
Before you get started with Protocol Exerciser for OBSAI, 
you need to know how to access it. Accessing Protocol 
Exerciser for OBSAI requires you to specify whether you 
want to connect to a new or an existing session, and the 
name of the server where you want to start the session.

If a new session is requested, the following occurs:

1 You can add a serial I/O module and its port to the 
session.

2 The serial I/O module downloads the necessary FPGA and 
embedded software from the control PC.

To specify all required inputs, Protocol Exerciser provides 
two dialog boxes: Select type of session and Port Selection to 
use.

The Select type of session opens up as shown in Figure 7.
OBSAI Interface Tester User’s Guide 12
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Figure 7 Select type of session screen

Table 1 briefly describes the components of the Select type 
of session dialog box.
19
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Table 1 Components of the Select type of session dialog box.

The Port Selection screen opens up as shown in Figure 8.

Component Description

Connect to existing session Select Connect to existing session if 
you want to use an existing session of 
Protocol Exerciser for OBSAI on a
known server.

Connect to new session Select Connect to new session if you 
want to create a new Protocol 
Exerciser for OBSAI session on a
known server.

Connect Offline Select Connect Offline if you want to 
work in off-line mode. Working in 
off-line mode does not connect you to 
the hardware.

Server Specifies the name or IP address of 
the server, where you want to start a 
new or join an existing Protocol 
Exerciser session. Its default value is
localhost. Also, this text field is 
disabled if you have selected the 
Connect Offline option.

Label Provide a label to the connecting 
session, if desired

Session list Displays a list of sessions existing on 
the server you specified in the Server 
text field.

Start Click Start to log on to the Protocol 
Exerciser for OBSAI application

Exit Click Exit to close the dialog box 
without starting the Protocol Exerciser 
application.

Help Click Help to display the online help
OBSAI Interface Tester User’s Guide 12
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Figure 8 Port Selection screen

Table 2 briefly describes the components of the Port 
Selection screen.
21
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Table 2 Components of the Port Selection screen

To start an session from a client:

1 On the Windows task bar, click Start > Programs 
>Agilent System Protocol Tester > Exerciser for OBSAI.

The Select type of session appears.

Component Description

Module Provides a list of attached modules.

Type Provides the type of port of each module.

# Ports Displays the number of ports of each module.

Licence Displays the licence details of each module.

Status Displays the current state of the module, e.g., ready, 
rebooting, or in use by session.

Select Ports to use Displays a check box list of ports of the modules. Here, 
select a port to start a new session.

OK Click OK to start an instance of Protocol Exerciser for 
OBSAI on the selected port.

Cancel Click Cancel to close the Port Selection dialog box 
without selecting any port.

Help Click Help to display the online help
OBSAI Interface Tester User’s Guide 12
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Figure 9 Select type of session screen

2 Do one of the following:

a Click Connect to existing session to use an existing 
session.

b Click Connect to new session to start a new session.

c Click Connect Offline to access Protocol Exerciser 
without connecting to the hardware.

3 Type in the name or IP address of the server, where you 
want to start a new or join an existing session, in the 
Server text field.

4 If you are trying to use an existing Protocol Exerciser 
session, do the following:

a Click session list. A list of sessions currently running 
on the server specified in the Server text field is 
displayed in Session list.

b Select the required session from Session list.

c Click Start. The main Protocol Exerciser for OBSAI 
window appears.
23
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5 If you are trying to create a new Protocol Exerciser for 
OBSAI session, do the following:

a Enter the network name of the controller PC in the 
Server text field. So, that it can communicate with the 
controller PC.

b Provide a label to the connecting session, if desired.

c Click Start. The Port Selection dialog box appears.

d Select a module name from the Select Modules to use 
pane.

e Select a port check box of the module from the Select 
Ports to use pane.

f Click OK. The main Protocol Exerciser window 
appears.
Exiting Protocol Exerciser for OBSAI

NOTE You can also connect to the OBSAI session, on clicking  from the 
Logic Analyzer GUI.
You can exit from the Protocol Exerciser application by 
closing the current sessions and the Protocol Exerciser for 
OBSAI window.

To exit Protocol Exerciser for OBSAI:

1 Click File > Exit.

The Closing Session dialog box appears. (Figure 10).
Figure 10 Closing Session dialog box

2 Do one of the following:

a Click Yes. This closes the Protocol Exerciser for OBSAI 
window and also removes the associated session.

b Click No. This closes the Protocol Exerciser window 
without removing its associated session.
OBSAI Interface Tester User’s Guide 12
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The Protocol Exerciser for OBSAI allows you to generate and 
respond to all types of OBSAI transactions. In addition, it 
allows you to create various OBSAI protocol variations and 
violations.

Another key feature is the ability to insert errors and test 
the behavior of device in response to these errors. Errors 
can be generated and inserted on the physical and data link. 
It is used to debug a device.
25Agilent Technologies



2 Getting Started
About Protocol Exerciser Components
26
Protocol Exerciser provides various components, that can be 
accessed.

Figure 11 displays the Protocol Exerciser application screen 
with its main components.
Figure 11 Protocol Exerciser Application screen

This section covers the following topics:

• Using the Menu Bar

• Using the Toolbar

• Using the Panes
OBSAI Interface Tester User’s Guide 12
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Using the Menu Bar
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The Menu Bar is one way to access the functionality of the 
application. In Protocol Exerciser, menu bar provides the 
following menus:

• File menu

• Edit menu

• View menu

• Action menu

• Help menu

File menu

Table 3 briefly describes the File menu commands.

Action menu

Table 4 briefly describes the Action menu commands.

Table 3 File Menu Commands

Menu commands Description

New Displays the Port Selection screen to select a new port.

Open Displays the Open dialog box, that enables you to open the 
saved configuration file.

Save Displays the Save dialog box that enables you to save the 
configuration file. If you are saving it for the first time, then 
this menu command saves the information at the default 
location. Otherwise, this menu command saves it on the 
last saved location.

Save As Displays the Save As dialog box that enables you to specify 
the desired location to save the file.

Close Closes the selected session.

Exit Closes the Protocol Exerciser application.

Table 4 Action Menu Commands

Menu commands Descriptions

Run Starts sending RP3/RP3-01 frames.

Stop Stops sending frames.

Run RP1 Starts sending RP1 syncburst information.
27
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2 Getting Started
Help Menu

Table 5 briefly describes the Help menu commands.

Stop RP1 Stops sending RP1 syncburst information.

Start Memory Compare Starts comparison of incoming RP3/RP3-01 frame 
with the configured compare memory frames.

Stop Memory Compare Stops comparison of incoming RP3/RP3-01 frame.

Table 5 Help Menu Commands

Menu commands Descriptions

Online Help Displays the online help for Protocol Exerciser.

Version Information Displays the version information of the Protocol 
Exerciser application.

About Displays information about the OBSAI Link Interface 
Tester platform.

Table 4 Action Menu Commands

Menu commands Descriptions
Using the Toolbar
Toolbar provides a quick access to the features of the 
Protocol Exerciser application.

Table 6 specifies the names of all toolbar icons.

Table 6 Toolbar icons

Icon Name

New

Save

Open
OBSAI Interface Tester User’s Guide 12
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Start RP3/RP3-01 Transmission.

Stop RP3/RP3-01 Transmission.

Run RP1 Transmission.

Stop RP1 Transmission.

Start Memory Compare.

Stop Memory Compare.

Table 6 Toolbar icons

Icon Name
Using the Panes
Protocol Exerciser provides the following panes:

• Navigation

• Hardware Status

Navigation

The Navigation pane further provides the following panes:

• Exerciser: This pane enables you to navigate between 
multiple setup files.

• <Setup_Filename>: Setup_Filename refers to the name of 
the setup file. This Overview pane provides options to use 
Protocol Exerciser for your test application.

Click <Setup_Filename> under Exerciser to view the 
Overview screen on the right pane (Figure 11).

Table 7 briefly describes the Overview screen.
29
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Hardware Status

The Hardware Status pane has the following tabs:

• RP1 Frame Number: This displays the RP1 frame number.

• TxLink Status: This tab provides the status information of 
the link width, link state.

• BER Status: This tab provides the status information of 
the bit error ratio for each link.

Table 7 Overview Screen

Component Description

Name Provide the desired name of the setup.

Pathname/Filename Provides the pathname or filename of 
the setup where it is saved.

Session Type Informs the current type of session. 
For e.g.: Existing session, new session, 
or Offline.

Description Provide description of the setup, if 
desired.

x Settings
General Settings

Click to display the General Settings 
screen.

x RP1 Configure
Configure RP1 properties

Click to display the RP1 Configuration 
screen.

x Frame Configuration
Configure RP3 frame data

Click to display the RP3 Frame Setup 
screen.

x Compare Memory
Configure Compare Memory

Click to display the Compare Memory 
screen.
OBSAI Interface Tester User’s Guide 12
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Tx Settings
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It defines the transmit side of the RP3 interface. For Base 
Station Extension Test module, there are four number of 
electrical links supported. And for Base Station Link Test 
Module, there is only one optical link and one electrical link.

To display the General Settings screen:

• Click xSettings General Settings tab provided in the 
Settings group.

The General Settings screen appears (Figure 12).
Figure 12 General Settings screen

Table 8 briefly describes the General Settings screen.
31
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Table 8 General Settings screen

Component Description

Run Mode The Run Mode section provides the 
following components:
• Normal Mode: The pattern of 

settings that runs by default.
• BER Mode: The pattern of settings 

that runs in Bit Error Ratio.

Available Links The following are the available links:
• Link 1 to Link 4: These links may be 

either electrical or optical. Base 
Station Link Test Module has two 
links, electrical and optical. Base 
Station Extension Test module has 
four electrical links. 

• BER Setup: The transmitter 
operates with Bit error ratio of 
better than 1*10-15 in the presence 
of input signal.There are four links 
to enable more than one bit error. 
Select the desired Pseudo Random 
Binary Sequence (PRSBS) type to 
continue. The links gets enabled 
when the BER mode is selected.
OBSAI Interface Tester User’s Guide 12
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Properties • Speed: The speed of the link can be 
either 0.7 Gbps [1X], 1.5 Gbps [2X], 
3.0 Gbps [4X].

• Clock Source: RP1 Insource can be 
either External, Internal, or RP3-01. 
It can be either Generated,or 
RP3-01 for RP1 Outsource. And the 
Sys Clock can be External, Internal 
or RP3-01.

• Line Code Violations: Physical 
layer, the 8b10b decoder, detects 
invalid line codes from the incoming 
serial bit stream. Each Line Code 
Violation (LCV) erroneously 
received byte is indicated to data 
link layer.It also transmits K30.7 
character to the link when data 
layer link indicates that the byte to 
be transmitted contains an error.

• Delta Master Frame Offset: Offset 
values of delta can be configured 
for each link before enabling the Tx. 
These values are specified in 4 byte 
clock ticks.

• Polarity: Select the Polarity of the 
links as positive or negative.

Table 8 General Settings screen

Component Description
33
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RP1 Configuration
34
The Exerciser is capable of acting as a CCM which can 
transmit sync burst, and it can extract the RP1 information 
either from the RP3- 01 interface or the RP1 interface. Sync 
burst is checked for correct CRC and expected frame type. 
Further, it extracts the frame number and compares it with 
the range of framenumber that can be stored in trigger 
storage. This RP1 configuration is not enabled in case of 
Base Station Extension Test Module.

An interleaved sequence of frame bursts can be defined of 
upto four different burst that transmits repetitively.

To configure RP1:

• Click RP1 configuration icon under <Setup_Filename>.

The RP1 Configuration screen opens up as shown in the 
Figure 13.
Figure 13 RP1 Configuration screen

Table 13 briefly describes the RP1 Configuration screen.
OBSAI Interface Tester User’s Guide 12
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Table 9 RP1 Configuration screen

Component Description

Sync Burst Templates It includes:
• Type: The expected type of frame 

used in RP1.
• Behaviour: To specify the RP1 

behaviour. For example: 
Startframenumber.

• Error Information: It consists of the 
incorrect Cyclic Redundancy Check 
(CRC), unexpected type of frame 
and incorrect frame number 

Configured Sync Bursts It includes:
• Index: It determines the index 

number.
• Type: The expected type of frame 

used in RP1.
• Behavior: To specify the RP1 

behaviour. For example: 
Startframenumber.

• Error Information: It consists of the 
incorrect Cyclic Redundancy Check 
(CRC), unexpected type of frame 
and incorrect frame number

Common parameters It includes:
• Sync Burst Interval: It transmits the 

RP1 frames. This property is 
common for all the frame type 
indexes. Time between the burst is 
in ticks
Sync Configuration Editor
The steps to edit a configured sync burst are as follows:

1 Select the sync burst that needs to be updated and click 
the check box to enable.

2 Click Edit.

The Sync Configuration Editor screen appears (Figure 14).
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Figure 14 Sync Configuration Editor screen

Table 10 briefly describes the Sync Configuration Editor 
screen

Table 10 Sync Configuration Editor Screen

Component Description

RP1 Frame Type Types of RP1 frames.

CRC Error Enable to insert an incorrect CRC. Sync 
burst checks for incorrect CRC in case 
no trigger occurs.

Frame type error Enable to set RP1 Frame type to be 
sent in case of error.

Frame number error Enable the value to be used to 
increment the RP1 frame number, in 
case of error. Frame number is an 64 
bit unsigned integer value that is 
incremented automatically by 1 with 
every frame.
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3 Click OK.

The steps to add or delete a configured sync bursts are as 
follows:

1 Click Add.

The Sync Configuration Editor screen opens up. For 
details, refer Figure 14. The added sync burst appears 
under Sync Burst Templates.

2 Click Delete to remove a Configured Sync Burst from the 
screen.

Sync Burst Error Interval Count of sync burst after which 
errored RP1 is to be sent.

Start Frame Number Specify the start frame number for 
RP1. This number will be incremented 
by 1 on each sync burst, if no error.

Table 10 Sync Configuration Editor Screen

Component Description
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Frame Configuration
38
Frame configuration is used to configure transmit side 
frames into the FGPA. The frames are encoded which is in 
the application format and program it into the FPGA buffers 
in the FPGA format.

It consists of two panes:

• RP3 Frame Setup

• Configuration

To configure frames:

1 Click Frame configuration icon under <Setup_Filename>.

The RP3 Frame Setup screen appears (Figure 15).
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Figure 15 RP3 Frame Setup screen
RP3 Frame Setup
It consists of four electrical links for Base Station Extension 
Test module and two links for Base Station Link Test 
module, one electrical and one optical. You can configure 
frames between 0 to 15, wherein 0 is by default. If there is 
no frames to be send, then transmit empty messages.
Configuration
The configuration pane consists of:

• Frame Templates

• Error Templates

Frame Templates

It includes Default like Empty frames and Pattern frames 4 
antennas.

User Configured

The steps to configure a frame are as follows:

1 Select User Configured.

2 Click .

The Frame Configuration screen appears.(Figure 16).
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Figure 16 Frame Configuration Data screen

3 Click Data.

This allows you to provide the Antenna Data.

a Address field: The Address controls the routing of 
each message. In downlink direction, from baseband to 
RF, all message transfers are point to point, and the 
address identifies the target node.

Address ‘00000000xxxxx’, where ‘x’ stands for either ‘0’ 
or ‘1’ bit, is reserved for initial booting of the bus 
network. Thus, node address ‘00000000’ is used only as 
default boot up address. It cannot be assigned 
permanently to any node.

Address 1FFFh is reserved for the empty message. 
Therefore, physical layer deletes all received messages 
with an all- ones address. However, addresses 
1FE0h- 1FFEh can be used, that is FFh node address is 
valid.

b Payload field: The Payload represents the content of 
the message with the type field. It defines the details 
of the selected address of the Antenna Data. The 
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payload size is fixed at 16 bytes. It is the responsibility 
of the application layer to map data to the payload.

c Types field: Application layer is responsible for 
defining the type of the message. The Type field 
identifies the content of the payload data.

d Timestamp field: The timestamp field relates the 
payload data to a specific time instant.

4 Click Control.

This allows you to provide the Header Data as shown in 
the Figure 17.

Figure 17 Frame Configuration Control screen

a Click Add to specify a address in the Address field.

b Select Type as Control Message or Empty Message.

c Specify a Start value and a Increment value, if desired 
in the Timestamp field.

d Select the Data format as Pattern or Increment.

e Click Ok.

Table 11 briefly describes the frame template icons.
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Error Templates

An error can be generated by configuring the error bits in 
the user message structure. It consists of the following:

a Disparity Error: For generating disparity error on nth 
byte of message.

b Symbol Error: For generating symbol error on nth byte 
of message.

c Idles BC: It represents the misplaced message delimiter

d Idles FC: It represents the misplaced frame delimiter.

e Control K- character: It represents the control symbol 
error.

Table 12 briefly describes the error template icons.

Behaviour Template: 

Table 11 Frame Template icons

Icons Descriptions

On clicking, the Frame Configuration 
screen pops up, wherein the frames 
needs to be configured by providing 
the Data and Control information.

On clicking, it edits or updates the 
configured frames.

Deletes the selected configured 
frames.

Table 12 Error Template icons

Icon Description

Changes the behaviour of a particular 
error by selecting an error template 
from the template tree.

Edits the selected error from the error 
template.

Deletes the selected error.
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Select the desired error to change the behaviour such as 
message number and byte number. It consists of two panes 
that is Location Parameters and Repeat Parameters.

1 Select the check box to Insert disparity error at 
delimiter.

2 Select the desired Message Group Number under 
Location Parameters.

3 Select the Message Number at desired location.

4 Select the Byte Number at desired location.

5 Quick Select/Deselect the following:

• Click Header to select or deselect the first 3 (for e.g.: 
0,1,2) Byte Number.

• Click Payload to select or deselect the remaining 16 
bytes.

6 Specify Repeat Interval and the Repeat Count to repeat 
the error after the specified message group as shown in 
the Figure 18.
Figure 18 Behaviour Template
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Compare Memory
44
The start comparison is determined by a defined frame 
number derived from RP1 sync interface. It can be initiated 
in two ways:

• Frame numbers through RP1: When the frame number is 
detected, comparison starts and compares first incoming 
frame with the first reference frame, second incoming 
frame with the second reference frame and so on. After 
the last reference frame used, it automatically continuous 
with the first reference frame. The incoming frames are 
compared to the reference frames saved in memory check 
on several kinds of error conditions.

• Manually: The comparison can be started manually 
through the toolbar.

To start Compare Memory:

• Click Compare Memory icon under <Setup_Filename>.

The Compare Memory screen opens up as shown in the 
Figure 19.
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Figure 19 Compare Memory screen
Data Configuration
You can configure the frames to be compared on the links as 
desired. You can also insert errors or mask certain bytes 
from comparison as desired.

To configure data:

• Click Data Configuration.

The Data Configuration screen opens up. Refer 
Figure 19.

For details, refer Configuration    39.
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Compare Properties
46
It includes the start and stop compare parameters on RP1 
frame type and frame number.

The Compare Properties screen opens up as shown in the 
Figure 20.
Figure 20 Compare Properties screen
Compare Statistics
It details the mismatch of the Byte Error Count and Bit 
Error Count of a particular RP1 frame number for each link. 
This occurs due to the change in the data or frames received 
with respect to the data or frames configured.

The Compare Statistics screen opens up as shown in the 
Figure 13.
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Figure 21 Compare Statistics screen

Table 13 briefly describes the Compare Statistics screen.

Table 13 Compare Statistics screen

Component Descriptions

Frame Number Displays the frame number of RP1.

Frame Type Displays the type of frame

Byte Error Count Displays the mismatched byte for a 
particular frame.

Bit Error Count Displays the mismatched bit for a 
particular frame.
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Emulating as Baseband Module

Base Station Link Test module is an extension of the Base 
Station Extension Test module protocol specifically designed 
for data transfer between a BTS and one or more Remote RF 
units (RRU). Base Station Link Test module is equivalent to 
the Base Station Extension Test module protocol except for 
the fact that different physical layer technologies, suitable 
for supporting data transmission over long distances, are 
applied. In order to minimize the number of connections to 
RRUs, RP1 data is mapped into RP3 messages. RP1 data 
includes ethernet and frame clock bursts.

Basically, Base Station Link Test module stands for an Base 
Station Extension Test module protocol where RP1 data is 
transferred in RP3 messages, between LCs and RRUs.
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General Settings
50
The steps to set the general settings are as follows:

1 Select the Normal Mode as Run Mode.

2 Select Optical link as Enable under Available Link.

3 Select the Link speed as 3.0 Gbps [4x] under Properties.

4 Select RP1 In Source as Internal.

5 Select RP1 Out Source as Generated.

6 Select Sys Clock as Internal.

7 Click Apply.

This applies the changes you made to set the general 
settings as shown in the Figure 22.
NOTE The Count and Time of Line Code Violations and the Delta Master Frame 
Offset remains as default.
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Figure 22 General Settings screen
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RP1 Configuration
52
The Control and Clock Module (CCM) provides frametiming 
information for each air interface standard, independently, 
via periodic synchronization bursts.

The steps to configure RP1 are as follows:

1 Click RP1 Configuration icon.

The RP1 configuration screen appears (Figure 23).
Figure 23 RP1 Configuration screen

2 Click Add under Sync Burst Templates to configure a 
RP1 data sync burst.

The Sync Configuration Editor dialog box appears 
(Figure 24).
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Figure 24 Sync Configuration Editor screen

3 Select the RP1 frame type as RP3 Bus FDD Frame 
Number.

4 Enable the errors, if desired to insert an error.

For Example: Enable the Frame type error and select 
RP3 Bus FDD Frame Number as an Invalid Frame type.

5 Select a specific sync burst to send errored RP1 frame 
repeatedly after every specified sync burst. 

For Example: Specify the Sync Burst Error Interval as 1.

6 Insert Start Frame Number under Behaviour.

7 Click OK.

The configured Sync Bursts appears.
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Figure 25 Configured Sync Burst

You can also replace the above sync template as 
configured sync burst 

8 Select the Sync Burst template.

9 Select a specific index of Configured Sync Bursts to use 
as above selected sync burst template.

For Example: Use above selected synctemplate as 
configured sync burst at following index as 1.

This overwrites the above selected sync burst template 
with the selected index of configured sync burst, if 
desired.

10 Specify the Sync Burst Interval (ticks) as 327200 by 
default.

11 Click Apply.

This applies the changes you made to set the RP1 
configuration.
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The Steps to configure the frame are as follows:

1 Select the required link on which the frames needs to be 
configured.

2 Drag and drop a Frame Template from the frame 
template on the desired link. 

For Example Link 1.

3 Select the Empty Frame under Configured Frame 0 
Errors.

4 Right click the Empty Frame as shown in the Figure 26.
Figure 26 RP3 Frame Setup

5 Select Edit.

The Frame Configuration screen appears (Figure 27).
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Figure 27 Frame Configuration Data screen

6 Click Data.

a Click Add to specify an Address in the Address field

b Select and click the check box of added Address to 
enable.

c Insert the required information in the Payload field as 
desired.

d Click Save to save the changes to be applied in the 
Payload field.

e Click Add to configure type in the Type field.

f Select and click the check box of added Type to 
enable.

g Click OK.

7 Click Control.

The Control screen of Frame Configuration appears 
(Figure 28).
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Figure 28 Frame Configuration Control screen

8 Click Add to specify a address in the Address field.

9 Select and click the check box of added Address to 
enable.

10 Select Type as Control Message or Empty Message.

11 Specify a Start value and a Increment value, if desired in 
the Timestamp field.

12 Select Format of Data as Pattern or Increment.

13 Click Ok.
Ethernet/Syncburst Configuration
The Ethernet/Sync burst Configuration is enabled only for 
Base Station Link Test module. It is used to send both the 
ethernet and sync burst simultaneously through this module.
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The steps to insert a sync burst in the RP3 Frame setup link are as follows:

1 Select the check box of Insert Sync Burst as shown in 
the Figure 29.
Figure 29 Insert Sync Burst

2 Click Ethernet/Syncburst Configuration icon to insert a 
sync burst.

The Ethernet/Syncburst Configuration screen opens up 
as shown in the Figure 30.
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Figure 30 Ethernet/Syncburst Configuration

3 Insert the message number to configure the Sync Burst.

For Example: Insert at message number as 2.

4 Select a count to repeat the Sync Burst after the specified 
message number.

For Example: Repeat after every following message as 1.

5 Select Data Source as Internal or User Configured, if an 
Ethernet configuration needs to be insert.

6 Click Ok.
Error Insertion
The steps to insert an error in the configured frames are as 
follows:

1 Select the desired error under the Error Template. 

For Example: Disparity Error.

2 Click Behavior Template icon to insert the error in the 
location and repeat parameters.
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The Behaviour Template screen appears (Figure 31).
Figure 31 Behaviour Template screen

3 Select the check box to Insert disparity error at 
delimiter for message group or frames.

4 Select a desired Message Group Number.

5 Select the required check box for Message Number and 
Byte Number.

6 Click Header of Quick Select/Deselect to select or clear 
all the header bytes number.

7 Click Payload of Quick Select/Deselect to select or clear 
all the payload bytes number.

8 Select a count to repeat the error after every specified 
message group.

For Example: Repeat Interval as 3.

9 Select the number of times to repeat the error.

For Example: Repeat Count as 4.

10 Click Ok.

11 You can also select a specific count of number frames to 
be configured.

For Example: Configure frames from as 1. Where 0 is 
considered as the first frame number.

12 Click Apply on the RP3 Frame Setup pane.
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The steps to Data Configuration on the compare memory are as follows:

1 Click Data Configuration tab as shown in the Figure 32.
Figure 32 Data Configuration screen

2 Click the desired link to configure the data on the frames.

For Example: Link 1.

3 Drag and drop an frame template.

4 Edit the address of the frame as required.
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For Example: Select 1FFF and edit the address by 
changing a bit in the pattern 2 from FFFFFFFF H to 
FFFFFFFE H. This changes the pattern of the frame as 
shown in the Figure 33.

Figure 33 Frame Configuration Data screen

5 Click Save.

6 Click OK.

7 Insert the error in the frames as desired from the error 
templates.

8 You can also select a specific count of number frames to 
be configured.

For Example: Configure frames from as 1. Where 0 is 
considered as the first frame number.

9 Click Apply.

This applies the changes you made to set the Data 
configuration of compare memory.
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It includes the start and stop compare parameters on RP1 
frame.

1 Click Compare on RP1 frame type checkbox under Start 
parameters and select the required frame type as 
RP1FrameType as shown in the Figure 34.
Figure 34 Compare Properties screen

2 Click Start compare on RP1 Frame Number checkbox.

3 Insert a specific frame number in the RP1FrameNumber 
field, to start the compare on the RP1 frame.

For Example: 0.

4 Click Stop compare on RP1 Frame Number checkbox 
under Stop Parameters.
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5 Insert a specific frame number in the RP1FrameNumber 
field, to stop the compare on the RP1 frame.

For Example: 100.

6 Click Start Compare Memory icon from the toolbar.

You can view the compare statistics, once the compare 
memory automatically stops.
Compare Statistics

NOTE You need to click Stop Compare Memory icon from the tool 
bar, if no specific frame type or frame number is selected.
It details the mismatch of the Byte Error Count and Bit 
Error Count of RP1 frame number for a particular RP1 
frame number in each link.

1 Click Compare Statistics to view the mismatch details as 
shown in the Figure 35.
Figure 35 Compare Statistics screen
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Rx side defines the receive side of RP3/RP3- 01 interface to 
receive the incoming frames. Each link is synchronized 
individually before the transfer of data. The state 
Frame_Sync is the normal operational mode with frame 
structure detected and messages received.

1 Enable the Optical Link.

2 Select RP1 In Source as External/RP3- 01 as shown in 
the Figure 36

3 Select Sys Clock Source as desired.

For Example: Generated.
Figure 36 General Settings of Rx

4 Click Apply.

This applies the changes made to set the general settings 
for Rx.
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Agilent OBSAI Protocol Tester
User’s Guide
4
Logic Analyzer for OBSAI

Accessing Logic Analyzer for OBSAI    68

Adding OBSAI Protocol Analyzer Module    70

Packet Decoder    81

Packet Viewer    83
This chapter provides information regarding the Rx side of 
OBSAI protocol tester through the Logic Analyzer GUI. The 
logic analyzer captures and set triggers on the incoming 
frames, decodes the OBSAI frames and displays the captured 
frames.
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Accessing Logic Analyzer for OBSAI
68
To start a session from the logic analyzer:

1 On the Windows task bar, click Start > Programs 
>Agilent Logic Analyzer> Agilent Logic Analyzer.

The Offline Startup Options screen opens up as shown 
in Figure 37.
Figure 37 Offline Startup Options screen

2 Click OBSAI to connect to OBSAI session.

The Agilent Logic Analyzer Overview screen opens up as 
shown in the Figure 38.
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Figure 38Agilent Logic Analyzer Overview screen
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Adding OBSAI Protocol Analyzer Module

Connection
70
The OBSAI session can be in two ways:

• Creating a new session and attaching to it.

• Attaching to a pre- existing session.

Create New Session

The steps to create a new session are as follows:

1 Click Add External Protocol Exerciser from Setup menu 
command.

The External Protocol Analyzer Setup for My Protocol 
Analyzer- 1 screen opens up as shown in the Figure 39.
Figure 39 External Protocol Analyzer Setup screen

2 Click Create New Session.
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The Create New Session dialog box opens up and the 
session appears as shown in the Figure 40.

Figure 40 Create New Session dialog box

3 Select a module from the list of modules attached.

4 Click OK.

The selected module appears on the Connection screen.

5 Click Refresh to revive the module number, port number 
and the status of the modules.

6 Select a module from the list of modules attached from 
the Connection screen as shown in the Figure 41.
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Figure 41 Connection screen

7 Click Connect to a Session.

The module gets connected as shown in the Figure 42.
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Figure 42 Session Connected screen

Attaching to Pre-existing Session

The steps to get a session list are as follows:

1 Click Get Session List to get the ObsaiExerciser session.

2 Select a module from the list of modules attached.

3 Click Connect to a Session.

The module gets connected as shown in the Figure 42.

4 Click OK.
NOTE Click Disconnect Session to detach from the existing connected session.
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External Protocol Analyzer
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The My Protocol Analyzer panel under modules column 
appears by default. You may change the name as desired. it 
consists of the following icons as shown in the Figure 43.

Figure 43My Protocol Analyzer panel

Table 14 represents the icons of My Protocol Analyzer 
panel.

Table 14 My Protocol Analyzer Icons

Icon Description

Add tool/windows to add windows 
(For e.g. Packet Viewer to display 
captured OBSAI frames) and use the 
tools (For e.g. Packet Decoder to 
decode OBSAI frame).

Connection Setup to connect to a 
session.

Trigger Configuration to configure 
triggers on frames.

Launch OBSAI Exerciser to connect 
the OBSAI exerciser to the session.
Trigger Configuration
A trigger is a combined set of conditions and their 
associated actions.

The steps to configure a trigger in the frames are as follows:

1 Click  in the My Protocol Analyzer panel.

The External Protocol Analyzer Setup for My Protocol 
Analyzer screen opens up with the selected Trigger 
Configuration tab as shown in the Figure 44.
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Figure 44 Trigger Configuration screen

Table 15 briefly describes the Trigger Configuration screen.

Table 15 Trigger Configuration

Component Description

RP1 Trigger Properties • Enable the Trigger on RP1 Frame 
Number Range. The RP1 Frame 
Number Range settings consists 
of:
• Minimum Range: It’s a 64 bits 

value.
• Maximum Range: It’s a 64 bits 

value.
• Enable the Trigger on RP1 Frame 

Types. Select a frame type of RP1 
from RP1 Frame Types. One or more 
frame type can be selected.
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Trigger Message Patterns It consists of four message patterns. 
You can select multiple message 
pattern. Click Edit, to update the 
parameters accordingly. Select the 
desired parameter and update the 
remaining as DON’T CARE. For eg: 
Kbits, Address, Payload, etc. These 
can be used for more than one link.

RP3 Trigger Properties Select trigger options to be used for 
the link. For eg: Disparity, Symbol, 
Memory compare, etc. If more than 
one option is selected. The trigger 
occurs at any of the selected options. 
It is a link based property.

Apply Click Apply to apply the changes you 
made to set the trigger configurations.

Table 15 Trigger Configuration

Component Description
Properties
The steps to set the properties of Rx link are as follows:

1 Click Properties.

The Properties screen opens up as shown in the 
Figure 45.
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Figure 45 Properties screen

Table 16 briefly describes the Properties screen.

Table 16 Properties

Component Description

Link  It includes four properties:
• Active Link: The number of links 

available to enable. This is a link 
based property

• Link Speed: The speed of the 
enabled link. This property is 
independent of the link, it applied 
for all links. This is applicable to 
more than one link

• Link Status: It can be enabled or 
disabled.This is a link based 
property

• Link Polarity: It can be positive or 
negative.This is a link based 
property
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State Machine The parameters of state machine 
appears has the default values as 
shown in the Figure 45.This is a link 
based property

Capture Settings It includes:
• Maximum number of frames to 

capture: The number of frames 
captured after the trigger point is 
known as capture.

• Maximum number of frames to 
Pre-capture: The number of frames 
captured before the trigger point is 
known as pre-capture.

The maximum number of frames to 
pre-capture should be equal or less 
than the maximum number of frames 
to capture. The maximum number of 
frames to capture and precapture is 
16. This is applicable to more than one 
link

RP1 The RP1 Clock is selected as External. 
It is enabled only for RP3-01 module 
for Rx side.This is applicable to more 
than one link.

Apply Click Apply to apply the changes you 
made to set the properties.This is 
applicable to more than one link

Table 16 Properties

Component Description
Status
The steps to view the status of Rx link are as follows:

1 Click Status.

The Status screen appears as shown in the Figure 46.
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Figure 46 Status screen

Table 17 briefly describes the Status screen.

Table 17 Status

Component Description

Status It includes:
• Symbol error count: Displays the 

count of symbol error. This is link 
based

• Disparity Error count: Displays the 
count of disparity error. This is link 
based

• RP1 frame Number: Displays the 
RP1 frame number. This is 
applicable to more than one link.
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Capture Setup It includes:
• Capture State: The capture state 

can be running or stopped. This is 
applicable to more than one link

• Frames Captured: The number of 
captured frames. This is applicable 
to more than one link

• Rx Link State: The status of Rx link. 
This is link based

Start/Stop Click Start to start capturing the 
frames. And the capturing of frames is 
automatically stopped in case of 
trigger. It can also be stopped 
manually.

OK Click OK to the applied changes.

Cancel Click Cancel to close the existing 
screen.

Help Click Help to display the online help.

Table 17 Status

Component Description
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The steps to configure a packet decoder properties are as 
follows:

1 Click  in the My Protocol Analyzer panel under 
modules column.

2 Select New Tool > Packet Decoder as shown in the 
Figure 47. The Packet Decoder panel appears under 
Tools column.
Figure 47 Packet Decoder

3 Click Properties.

The Packet Decoder Properties dialog box opens up as 
shown in the Figure 48.
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Figure 48 Packet Decode Properties dialog box

4 Select OBSAI as Protocol family under Protocol 
Selection.

5 Select ObsaiFrameDownlink/Uplink as Decode Bus.

6 Click Apply.

7 Click OK.
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The steps to configure a packet viewer are as follows:

1 Click  in the Packet Decoder panel under Tools 
column.

2 Select New Window > Packet Viewer as shown in the 
Figure 49.
Figure 49 Packet Viewer

The Packet Viewer panel appears under Windows column as 
shown in the Figure 50.
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Figure 50 Packet Viewer Panel

3 Click Show.

The Packet Viewer screen opens up as shown in the 
Figure 51.
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Figure 51 Packet Viewer screen

4 Click  to upload data to viewer.

The OBSAI packets with the details like its Address, 
payload information, time etc.
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The steps to add a column to view the desired information 
about OBSAI packets.

1 Right click the column heading. Select the desired option 
to insert a column before or after the selected column as 
shown in the Figure 52.
Figure 52 Insert Column screen

2 The list of column details that can be viewed opens up as 
shown in the Figure 53.
OBSAI Tester User’s Guide



Logic Analyzer for OBSAI 4

OBSAI Tester User’s Guide
Figure 53 Insert Before dialog box

3 Click the desired information that needs to be viewed. 
This information appears as the column heading.
Setting a Marker
The steps to set a marker to the OBSAI packets are as 
follows:

1 Select the desired OBSAI packet.

2 Right click and goto Place Marker > New Marker as 
shown in the Figure 54.
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Figure 54 Place Marker

The New Marker dialog box opens up as shown in the 
Figure 55.

Figure 55 New Marker dialog box
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3 Specify the required details in the New Marker dialog 
box.

4 Click OK.

The Marker is set to the OBSAI packet.

Time Interval Measurement

The steps to measure the time interval between two markers 
are as follows:

1 Right click on the measurement bar and select New Time 
Interval Measurement as shown in the Figure 56.
Figure 56 New Time Interval

The Time Interval dialog box opens up as shown in the 
Figure 57.
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Figure 57 Time Interval dialog box

2 Specify the From and to markers to measure the time 
interval.

3 Click OK.

The time interval measurement appears on the 
measurement bar.

Table 18 briefly describes the icons available:

Table 18 Icons Descriptions

Icon Description

Displays the New Marker dialog box.

Displays the Marker dialog box.

Displays the Time Interval dialog box.

Displays the value to screen.

Displays the Start point of the captured frames.

Displays the triggered frame.

Displays the End point of the captured frames.
Searching OBSAI Data
• Click  to find Obsai Packets like Frame Delimiter, 
Tetra or Error Messages.

• Click  to find the previous Obsai data.

• Click  to find the next Obsai data.

The Find dialog box opens up as shown in the Figure 58.
OBSAI Tester User’s Guide



Logic Analyzer for OBSAI 4

OBSAI Tester User’s Guide
Figure 58 Find dialog box

To search a Frame Delimiter

1 Specify the number of frame delimiter to search in the 
Find field.

2 Select the occurrence searching as Forward or Backward 
and select the desired From location to search.

3 Select the Bus/Signal from the dropdown menu in the 
dialog box.

4 Select All bits as ObsaiDataMsg.

5 Select the obsai packet as FC with And option.

6 To search a frame delimiter in the payload, select 
alyzer- 3 Delimiter. 

7 Select Rising Edge as alyzer- 3 Delimiter from the 
dropdown menu.

8 Click Find.

The following Figure 59 appears.
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Figure 59 To search a Frame Delimiter

To Search a Tetra

1 Specify the number of tetra to search in the Find field.

1 Select the occurrence searching as Forward or Backward 
and select the desired From location to search.

2 Select the Packet from the dropdown menu in the dialog 
box. 

3 Select the Obsai Packet as Tetra.

4 Click Find.

The following Figure 60 appears.
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Figure 60 To search a Tetra
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